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About ViewMail for Outlook (Version 8.0 Only)

Note  This content applies to ViewMail for Outlook version 8.0 only. For later ViewMail versions, see the
Quick Start Guide for Cisco ViewMail for Microsoft Outlook (Release 8.5 and Later) at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/vmo/quick_start/guide/85xcucqsgvmo.
html.

Cisco Unity Connection ViewMail for Microsoft Outlook lets you send, listen to, and manage voice
messages from Outlook. In the ViewMail for Outlook form, you use the controls on the Media Master
to play and record voice messages.

You can use ViewMail for Outlook to send voice messages to other users, non-Connection users, and
public distribution lists.

You cannot use ViewMail from the preview pane in Outlook. You must open the message to use
ViewMail for Outlook.

You can change ViewMail for Outlook settings to:
¢ Choose the sound that notifies you of new voice messages.
e Set a preference for saving sent voice messages in your Outlook folders.

e Set automatic playback so that your voice messages begin playing as soon as you open them.

To Access ViewMail for Outlook Help

Step 1 In Outlook, from the Help menu, click ViewMail Help Topics.
Step2  Click a topic link in the left pane.
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Working with the Media Master in ViewMail for
Outlook (Version 8.0 Only)

This content applies to ViewMail for Outlook version 8.0 only. For later ViewMail versions, see the
Quick Start Guide for Cisco ViewMail for Microsoft Outlook (Release 8.5 and Later) at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/vmo/quick_start/guide/85xcucqsgvmo.
html.

e About the Media Master (Version 8.0 Only), page 3
e Using Sound Files in Your Recordings (Version 8.0 Only), page 4
e Changing Recording and Playback Devices with the Media Master (Version 8.0 Only), page 4

¢ Changing Message Playback Volume When Computer Speakers Are Your Playback Device (Version
8.0 Only), page 5

e Changing Message Playback Speed When Computer Speakers Are Your Playback Device (Version
8.0 Only), page 5

e Media Master Keyboard Shortcuts (Version 8.0 Only), page 6

About the Media Master (Version 8.0 Only)

The Media Master appears in messages that you manage by using ViewMail for Outlook. You record and
play messages by clicking the Media Master controls.

You also use the Media Master to change the recording and playback devices you use while working with
ViewMail for Outlook, and to change the playback volume and playback speed for messages.

Updates to Media Master settings are saved per user, per computer. If you also use another computer to
access the Media Master (for example, a computer at home), you need to update the Media Master
settings on the second computer as well.

[ oL-21247-01

User Guide for Accessing Cisco Unity Connection Voice Messages in an Email Application (Release 8.x) g




http://www.cisco.com/en/US/docs/voice_ip_comm/connection/vmo/quick_start/guide/85xcucqsgvmo.html


http://www.cisco.com/en/US/docs/voice_ip_comm/connection/vmo/quick_start/guide/85xcucqsgvmo.html

Working with the Media Master in ViewMail for Outlook (Version 8.0 Only) |

B Using Sound Files in Your Recordings (Version 8.0 Only)

Using Sound Files in Your Recordings (Version 8.0 Only)

The Options menu—the first button (down arrow) on the Media Master—allows you to use other sound
(WAV) files in your recordings. The following sound file options are available:

New Erase a recording to rerecord.
Paste Paste a sound recording from the clipboard the same way you paste text in a text file.
Paste from File Paste another sound file to a recording.
Copy Copy a sound recording to the clipboard the same way you copy text in a text file.
Copy to File Copy the recording to a sound file that you name.

If the message is marked secure, this option will be unavailable.

Changing Recording and Playback Devices with the Media
Master (Version 8.0 Only)

You can choose the devices that you use for recording and playing messages while working with
ViewMail for Outlook:

Recording devices e Phone—Cisco Unity Connection calls you, and you speak into the phone
handset or into the speakerphone microphone.

e Computer microphone (if available).

Playback devices e Phone—Cisco Unity Connection calls you, and you listen through the phone
handset or through the speakerphone speaker.

e Computer speakers (if available).

Tip The phone offers the best sound quality for recordings.

To Change Your Recording or Playback Device with the Media Master

Step 1 In the Outlook folder that contains your voice messages, open a message.

Step 2 On the Media Master, from the Options menu (first button, down arrow), click either Playback Devices
or Recording Devices, and choose the device that you want to use in the list.

Step3  If you chose Phone as the device, confirm that the phone information is correct:
a. From the Options menu, click Options.

b. In the Cisco Unity Connection Server Options dialog box, in the Cisco Unity Connection Server
Name box, enter the name of your Connection server. (If you do not know the server name, contact
your Connection administrator.)

c. In the User Name box, enter your Connection username.

d. In the Password box, enter your Cisco PCA password.
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| Working with the Media Master in ViewMail for Outlook (Version 8.0 Only)
Changing Message Playback Volume When Computer Speakers Are Your Playback Device (Version 8.0 Only) ||

e. Check the Remember Password check box if you want ViewMail for Outlook to remember your
password so that you do not have to re-enter it each time you restart Outlook.

f. If your organization uses a proxy server, in the Proxy Server Address box, enter the IP address of
the proxy server.

g. If your organization uses a proxy server, in the Proxy Server Port box, enter the server port number
ViewMail for Outlook must use when connecting to the proxy server.

h. If your Connection administrator tells you to, check the Validate HTTPS Certificate check box.
Otherwise, leave it unchecked.

i. In the Extension box, enter your extension.
j. Click OK.
Stepd  Click Close to close the message.

Changing Message Playback Volume When Computer Speakers
Are Your Playback Device (Version 8.0 Only)

The procedure in this section changes the playback volume for all messages played with ViewMail for
Outlook when your computer speakers are set as the playback device in the Media Master.

To Change Message Playback Volume When Computer Speakers Are Your Playback Device

Step1  In the Outlook folder that contains your voice messages, open a message.

Step2  On the Media Master, click and drag the Volume Control slider to decrease or increase playback
volume.

Step3  Click Play to play the message, which saves the volume setting for messages that you listen to through
your computer speakers.

Step4  Click Close to close the voice message.

Changing Message Playback Speed When Computer Speakers
Are Your Playback Device (Version 8.0 Only)

The procedure in this section changes the playback speed for all messages played with ViewMail for
Outlook when your computer speakers are set as the playback device in the Media Master.

To Change Message Playback Speed When Computer Speakers Are Your Playback Device

Step 1 In the Outlook folder that contains your voice messages, open a message.
Step2  On the Media Master, click and drag the Speed Control slider for slower or faster playback.

Step3  Click Play to play the message, which saves the speed setting for messages that you listen to through
your computer speakers.
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Working with the Media Master in ViewMail for Outlook (Version 8.0 Only) |

Bl  Media Master Keyboard Shortcuts (Version 8.0 Only)

Stepd  Click Close to close the voice message.

Media Master Keyboard Shortcuts (Version 8.0 Only)

Table 1 lists the keyboard shortcuts available for working with the Media Master in ViewMail for

Outlook.

Table 1 Keyboard Shortcuts for the Media Master in ViewMail
Key(s) Action

Alt-Shift-P Play/Pause
Alt-Shift-S Stop

Alt-Shift-R Record/Pause
Alt-Shift-M Open Options menu
Alt-Shift-F3 Skip back
Alt-Shift-F4 Skip forward
Alt-Shift-F7 Decrease volume
Alt-Shift-F8 Increase volume
Alt-Shift-F11 Slower playback
Alt-Shift-F12 Faster playback

You can also use the keyboard to make selections on the Options menu. Press the letter that is underlined
for the option you want to select on the Options menu.
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Managing Messages with ViewMail for Outlook
(Version 8.0 Only)

Note  This content applies to ViewMail for Outlook version 8.0 only. For later ViewMail versions, see the
Quick Start Guide for Cisco ViewMail for Microsoft Outlook (Release 8.5 and Later) at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/vmo/quick_start/guide/85xcucqsgvmo.
html.

e Sending Voice Messages (Version 8.0 Only), page 7

e Checking Messages (Version 8.0 Only), page 8

e Replying to Messages (Version 8.0 Only), page 8

e Forwarding Voice Messages (Version 8.0 Only), page 9
e Managing Deleted Messages (Version 8.0 Only), page 9

Sending Voice Messages (Version 8.0 Only)

You can send voice messages and record responses to messages from Outlook. You can send, reply to,
and forward messages to users, as well as to public distribution lists and email addresses.

If your organization has multiple locations, you may be able to send and respond to messages to users
at another location. Ask your administrator for details.

Note  When your Cisco Unity Connection mailbox exceeds its size quota, you may not be able to send
messages. (See the “Managing the Size of Your Mailbox” section on page 33.)

To Send a Voice Message

Step 1 In your Outlook Inbox, on the Outlook toolbar, click the New Voice Message icon.
Or

From the Actions menu, click New Voice Message.
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Managing Messages with ViewMail for Outlook (Version 8.0 Only)

Bl Checking Messages (Version 8.0 Only)

Step 2

Step 3
Step 4
Step 5
Step 6

Enter Connection usernames or email addresses, and a subject.

A

Note  Messages addressed to email addresses are sent as sound (WAV) files attached to email
messages.

On the Media Master, click Record (circle) and record the message.
When you finish recording, click Stop (square).

Add text and attachments as applicable.

Click Send.

Checking Messages (Version 8.0 Only)

Step 1

Step 2
Step 3

You can check voice messages and receipts in Outlook. Voice messages and receipts appear in a separate
Outlook folder from your email.

Once you have opened a new message, it is saved until you delete it. Ask your administrator if
Connection is set up to enforce a message-retention policy, and, if so, how long the system stores your
messages before permanently deleting them. Connection does not indicate when a message-retention
policy is enforced, nor does it warn you before messages are permanently deleted as a result of such a
policy.

Information in the From field identifies the sender. The field contains the name of a Connection user, or
it will contain “Unity Connection Messaging System” when a message is left by someone who is not a
Connection user or by a user who did not log on to Connection before leaving the message. The Subject
field displays the phone number of the caller, if it is available.

Depending on how the system is set up, you may see other types of messages (for example, fax messages)
in the Outlook folder that contains your voice messages.

To Check a Message

In the Outlook folder that contains your voice messages, double-click a message to open it.

N

Note  You cannot check messages in the Outlook Preview pane.

In the open voice message, on the Media Master, click Play (right arrow) to play the message.

In the message, use the buttons on the message toolbar to manage the message the same way you handle
email messages.

Replying to Messages (Version 8.0 Only)

Do the procedure in this section to reply to a voice message or to reply to an email message by recording
a reply. You can respond to only the sender, and you can add recipients.
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| Managing Messages with ViewMail for Outlook (Version 8.0 Only)

Step 1

Step 2
Step 3
Step 4
Step 5

Forwarding Voice Messages (Version 8.0 Only)

A message from “Unity Connection Messaging System” means that the caller was not a Connection user
or was not logged on when the message was left. You cannot reply to messages from such callers.

To Reply to a Message

In the open voice message, click Reply.

Or

In the open email message, from the Actions menu, click Reply with Voice.
On the Media Master, click Record (circle).

When you finish recording, click Stop (square).

Add text and attachments as applicable.

Click Send.

Forwarding Voice Messages (Version 8.0 Only)

Step 1

Step 2
Step 3
Step 4
Step 5
Step 6

Do the procedure in this section to forward a voice message as is or to record an introduction that plays
before a forwarded voice or email message.

To Forward a Voice Message

In the open voice message, click Forward.

Or

In the open email message, from the Actions menu, click Forward with Voice.
Enter the names of recipients.

On the Media Master, click Record (circle) and record an introduction.

When you finish recording, click Stop (square).

Add text and attachments as applicable.

Click Send.

Managing Deleted Messages (Version 8.0 Only)

You delete messages from the Outlook folder that contains your voice messages the same way you delete
email messages. However, deleted voice messages are displayed with gray strike-through text. Deleted
voice messages remain in your voice message folder until Cisco Unity Connection purges them.

Connection may automatically purge deleted messages once they reach a certain age. Ask your
administrator how long messages are stored before they are permanently deleted for you. This way you
can plan to archive or move important messages ahead of time.
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Managing Messages with ViewMail for Outlook (Version 8.0 Only) |

B Managing Deleted Messages (Version 8.0 Only)

ﬁ To archive voice messages before deleting them, use the Copy to File option on the Media Master
Options menu.

You can also manually purge your deleted messages.

To Manually Purge Deleted Messages

In the Outlook folder that contains your voice messages, from the Edit menu, click Purge Deleted
Messages.
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Changing Settings for ViewMail for Outlook
(Version 8.0 Only)

Note  This content applies to ViewMail for Outlook version 8.0 only. For later ViewMail versions, see the
Quick Start Guide for Cisco ViewMail for Microsoft Outlook (Release 8.5 and Later) at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/vmo/quick_start/guide/85xcucqsgvmo.
html.

e Changing the Sound That Notifies You of New Voice Messages (Version 8.0 Only), page 11
e Changing the Automatic Voice Message Playback Setting (Version 8.0 Only), page 12

e Changing Your Preference for Saving Sent Voice Messages (Version 8.0 Only), page 12

e Changing Recording and Playback Devices (Version 8.0 Only), page 13

e Configuring Your Secure Messaging Settings (Version 8.0 Only), page 13

e Changing Your IMAP Account Setting (Version 8.0 Only), page 14

e Updating the Password in ViewMail for Outlook to Match Your Cisco PCA Password (Version 8.0
Only), page 14

Changing the Sound That Notifies You of New Voice Messages
(Version 8.0 Only)

You can choose the computer sound that notifies you when new messages arrive in the Outlook folder
that contains your voice messages. This option is available only if your computer has multimedia
speakers.

To Change the Sound That Notifies You of New Voice Messages

Step 1 From the Outlook Tools menu, click ViewMail Options.
Step2  In the ViewMail Options dialog box, click the Notification tab.
Step3  Choose your notification options.

To preview the sound for an option, click the Speaker icon.
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Changing Settings for ViewMail for Outlook (Version 8.0 Only) |

Bl Changing the Automatic Voice Message Playback Setting (Version 8.0 Only)

Stepd  If applicable, change the default sound for an option:

a. Click the Browse button.

b. In the Browse Files dialog box, choose a sound (WAV) file, then click Open.
Step5  When the ViewMail Options dialog box reappears, click OK to save your changes.

Changing the Automatic Voice Message Playback Setting
(Version 8.0 Only)

With automatic playback, your voice messages begin playing as soon as you open them in the Outlook
folder that contains your voice messages. Without automatic playback, you use the Media Master to play
voice messages.

To Change the Automatic Voice Message Playback Setting

Step 1 From the Outlook Tools menu, click ViewMail Options.
Step2  Click the General tab.

Step3  Check or uncheck the Play Voice Automatically check box.
Step4  Click OK.

Changing Your Preference for Saving Sent Voice Messages
(Version 8.0 Only)

When you configure Outlook to save copies of sent messages in the Sent Items folder, a copy of each
voice message that you send by using ViewMail for Outlook is also saved. To save space on your hard
disk, you can set ViewMail to save only the message headers and not save the message recordings. (A
message header contains the message recipient(s), when the message was sent, the subject, the
importance and sensitivity, and the size.)

To Save Only Voice Message Headers

Step 1 From the Outlook Tools menu, click ViewMail Options.

Step2  Click the General tab.

Step3  Check the Keep Only Message Header in the Sent Items Folder check box.
Step4  Click OK.
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Changing Recording and Playback Devices (Version 8.0 Only) 1l

Changing Recording and Playback Devices (Version 8.0 Only)

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6
Step 7
Step 8

Step 9

Step 10

Step 11

Step 12
Step 13

To Change the Recording or Playback Device

From the Outlook Tools menu, click ViewMail Options.

Click the Record or Playback tab.

In the Device list, select the device that you want to use.

If you did not choose Phone for your playback or recording device, skip to Step 13.
If you chose Phone for your playback or recording device, click the Server tab.

In the Cisco Unity Connection Server Name box, enter the name of your Connection server. (If you do
not know the server name, contact your Connection administrator.)

In the User Name box, enter your Connection username.
In the Password box, enter your Cisco PCA password.

Check the Remember Password check box if you want ViewMail for Outlook to remember your
password so that you do not have to re-enter it each time you restart Outlook.

If your organization uses a proxy server, in the Proxy Server Address box, enter the IP address of the
proxy server.

If your organization uses a proxy server, in the Proxy Server Port box, enter the server port number
ViewMail for Outlook must use when connecting to the proxy server.

If your Connection administrator tells you to, check the Validate HTTPS Certificate check box.
Otherwise, leave it unchecked.

In the Extension box, enter your extension.

Click OK.

Configuring Your Secure Messaging Settings (Version 8.0 Only)

Step 1
Step 2
Step 3

Step 4
Step 5
Step 6

When Cisco Unity Connection is configured to mark messages secure, you must configure Outlook so
that it can communicate securely with the Connection server.

To Configure Your Secure Messaging Settings

From the Outlook Tools menu, click ViewMail Options.
Click the Server tab.

In the Cisco Unity Connection Server Name box, enter the name of your Connection server. (If you do
not know the server name, contact your Connection administrator.)

In the User Name box, enter your Connection username.
In the Password box, enter your Cisco PCA password.

Check the Remember Password check box if you want ViewMail for Outlook to remember your
password so that you do not have to re-enter it each time you restart Outlook.
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Changing Settings for ViewMail for Outlook (Version 8.0 Only) |

I Changing Your IMAP Account Setting (Version 8.0 Only)

Step7  If your organization uses a proxy server, in the Proxy Server Address box, enter the IP address of the
proxy server.

Step8  If your organization uses a proxy server, in the Proxy Server Port box, enter the server port number that
ViewMail for Outlook must use when connecting to the proxy server.

Step9  If your Connection administrator tells you to, check the Validate HTTPS Certificate check box.
Otherwise, leave it unchecked.

Step10 Click OK.

Changing Your IMAP Account Setting (Version 8.0 Only)

If you have more than one IMAP account configured in Outlook, you need to identify the one that is
associated with Cisco Unity Connection.

To Change Your IMAP Account Setting

Step 1 From the Outlook Tools menu, click ViewMail Options.
Step2  Click the Accounts tab.

Step 3 In the Select the Accounts to Access Cisco Unity Connection With list, select the IMAP account that is
used to access Connection.

Step4  Click OK.

Updating the Password in ViewMail for Outlook to Match Your
Cisco PCA Password (Version 8.0 Only)

ViewMail for Outlook uses your Cisco Unity Connection username and Cisco PCA password to access
your Connection account to retrieve voice messages. You must update the password in ViewMail when
you change your Cisco PCA password in the Messaging Assistant web tool. This ensures that ViewMail
for Outlook can continue to access your Connection account.

If you are having trouble sending or receiving voice messages in ViewMail for Outlook, consider the
following tips:

e If Microsoft Outlook prompts you for a password but does not accept it, your Cisco PCA password
may have expired or changed, or it may be locked. Change your Cisco PCA password in the
Messaging Assistant first, then update the password in ViewMail for Outlook.

e If you receive an error when you attempt to play or record messages in ViewMail for Outlook by
using the phone, your Cisco PCA password may have expired or changed, or it may be locked.
Change your Cisco PCA password in the Messaging Assistant first, then update it in ViewMail.

e If you receive an error when you attempt to play or record secure messages, your Cisco PCA
password may have expired or changed, or it may be locked. Change your Cisco PCA password in
the Messaging Assistant first, then update it in ViewMail for Outlook.
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Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8
Step 9

Updating the Password in ViewMail for Outlook to Match Your Cisco PCA Password (Version 8.0 Only) [ |

To Update the Password in ViewMail for Outlook to Match Your Cisco PCA Password

From the Outlook Tools menu, click ViewMail Options.

Click the Server tab.

In the Password box, enter the new Cisco PCA password that you changed in the Messaging Assistant.
Click OK.

From the Outlook Tools menu, click Email Accounts.

Select View or Change Existing Email Accounts and click Next.

Select the IMAP account that is used to access Cisco Unity Connection and click Change.

In the Password box, enter the new Cisco PCA password that you changed in the Messaging Assistant.
Click Next, then click Finish.
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[ | Updating the Password in ViewMail for Outlook to Match Your Cisco PCA Password (Version 8.0 Only)
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About ViewMail for Notes

Cisco Unity Connection ViewMail for IBM Lotus Notes lets you send, listen to, and manage voice
messages from Notes. In the voice message form, you use the controls on the Media Master to play and
record voice messages.

You can use ViewMail for Notes to send voice messages to other users, non-Connection users, and public
distribution lists.

You cannot use ViewMail from the preview pane in Notes. You must open the message to use ViewMail
for Notes.

To Access ViewMail for Notes Help

Step 1 In your ViewMail for Notes inbox, select the Help button.
Step2  Select a ViewMail for Notes topic link in the left pane.
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Working with the Media Master in ViewMail for
Notes

e About the Media Master, page 19

e Using Sound Files in Your Recordings, page 19

e Changing Recording and Playback Devices with the Media Master, page 20

e Changing Message Playback Volume When Computer Speakers Are Your Playback Device, page 21
¢ Media Master Keyboard Shortcuts, page 21

About the Media Master

The Media Master appears in messages that you manage from your ViewMail for Notes inbox. You
record and play messages by clicking the Media Master controls.

You also use the Media Master to change the recording and playback devices you use while working with
ViewMail for Notes, and to change the playback volume for messages.

Updates to Media Master settings are saved per user, per computer. If you also use another computer to
access the Media Master (for example, a computer at home), you need to update the Media Master
settings on the second computer as well.

Using Sound Files in Your Recordings

The Options menu—the first button (down arrow) on the Media Master—allows you to use other sound
(WAV) files in your recordings. The following sound file options are available:

New Erase a recording to rerecord.
Paste Paste a sound recording from the clipboard the same way you paste text in a text file.
Paste from File Paste another sound file to a recording.
Copy Copy a sound recording to the clipboard the same way you copy text in a text file.
Copy to File Copy the recording to a sound file that you name.

If the message is marked secure, this option will be unavailable.
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Bl Changing Recording and Playback Devices with the Media Master

Changing Recording and Playback Devices with the Media
Master

You can choose the devices that you use for recording and playing messages while working with
ViewMail for Notes:

Recording devices e Phone—Cisco Unity Connection calls you, and you speak into the phone
handset, headset, or speakerphone microphone.

e Microphone—On your computer (if available).

Tip The phone offers the best sound quality for recordings.

Playback devices e Phone—Cisco Unity Connection calls you, and you listen through the phone
handset, headset, or speakerphone speaker.

e Speakers—On your computer (if available).

As you do the following procedure, if some fields do not already have values entered, you likely will
need to contact your Connection administrator for the required information.

To Change Your Recording or Playback Device with the Media Master

Step 1 In your ViewMail for Notes inbox, open a message.

Step 2 On the Media Master, select the down arrow (first button), then select either Playback Devices or
Recording Devices, and choose the device that you want to use in the list.

Step3  If you chose Phone as the device, verify your personal and server information:
a. On the Media Master, select the down arrow (first button), then select Options.

b. In the Cisco Unity Connection Server Options dialog, change settings as applicable:

Cisco Unity Connection Enter the name of the Connection server.

Server Name . .
Tip Values for the server name, username, password, and extension

fields appear automatically if the information was entered during
creation of the ViewMail for Notes account.

User Name Enter your Connection username.

Password Enter your Cisco Personal Communications Assistant password.

Remember Password Check the check box for ViewMail for Notes to remember the Cisco PCA
password so that you do not have to re-enter it each time Notes starts.

Proxy Server Address If there is a firewall that blocks HTTPS traffic between user workstations

and the Connection server, enter the IP address of the HTTPS proxy server.

Proxy Server Port If there is a firewall that blocks HTTPS traffic between user workstations
and the Connection server, enter the server port to use when connecting to
the HTTPS proxy server.

Validate HTTPS Certificate If your Connection administrator tells you to, check the check box.
Otherwise, leave it unchecked.

Extension Enter your extension.
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Changing Message Playback Volume When Computer Speakers Are Your Playback Device ||

c. Select OK.

Step4  Close the voice message.

Changing Message Playback Volume When Computer Speakers
Are Your Playback Device

The procedure in this section changes the playback volume for all messages played with ViewMail for
Notes when your computer speakers are set as the playback device in the Media Master.

To Change Message Playback Volume When Computer Speakers Are Your Playback Device

Step1  In your ViewMail for Notes inbox, open a voice message.

Step2  On the Media Master, click and drag the Volume Control slider to decrease or increase playback
volume.

Step3  Select Play (right arrow, second button) to play the message, which saves the volume setting for
messages that you listen to through your computer speakers.

Stepd  Close the voice message.

Media Master Keyboard Shortcuts

Table 1 lists the keyboard shortcuts available for working with the Media Master in ViewMail for Notes.

)

Note  These shortcuts work only when a single voice message is open. When multiple voice messages are open,
the shortcuts do not work.

Table 1 Keyboard Shortcuts for the Media Master in ViewMail
Key(s) Action

Alt-Shift-P Play/Pause

Alt-Shift-S Stop

Alt-Shift-R Record/Pause

Alt-Shift-M Open Options menu

Alt-Shift-F3 Skip back

Alt-Shift-F4 Skip forward

Alt-Shift-F7 Decrease volume

Alt-Shift-F8 Increase volume
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B Media Master Keyboard Shortcuts
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Managing Messages with ViewMail for Notes

¢ Sending Voice Messages, page 23

e Checking Messages, page 24

e Replying to Voice Messages, page 24
e Forwarding Voice Messages, page 25
e Managing Deleted Messages, page 25

Sending Voice Messages

Note

Step 1
Step 2

Step 3
Step 4
Step 5
Step 6

From your ViewMail for Notes inbox, you can send voice messages and record responses to messages.
You can send, reply to, and forward messages to users, as well as to public distribution lists and email
addresses.

If your organization has multiple locations, you may be able to send and respond to messages from users
at another location. Ask your administrator for details.

When your Cisco Unity Connection mailbox exceeds its size quota, you may not be able to receive new
messages. (See the “Managing the Size of Your Mailbox” section on page 19.)

To Send a Voice Message

In your ViewMail for Notes inbox, select New Memo.

Enter the names of Connection users or distribution lists, or email addresses, and a subject.

)

Note  Messages addressed to email addresses are sent as sound (WAV) files attached to email
messages.

On the Media Master, select Record (circle, fourth button) and record the message.
When you finish recording, select Stop (square, third button).

Add text and attachments as applicable.

Select Send.

[ oL-21247-01

User Guide for Accessing Cisco Unity Connection Voice Messages in an Email Application (Release 8.x) g
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Bl Checking Messages

Checking Messages

Step 1

Step 2

Step 3

In your ViewMail for Notes inbox, you can check voice messages and receipts.

Once you have opened a new message, it is saved until you delete it. Ask your administrator if
Connection is set up to enforce a message-retention policy, and, if so, how long the system stores your
messages before permanently deleting them. Connection does not indicate when a message-retention
policy is enforced, nor does it warn you before messages are permanently deleted as a result of such a
policy.

Information in the “from” area of the message (top left corner) identifies the sender. The box contains
the email address of a Connection user, or it will contain “Cisco Unity Connection Messaging System”
when a message is left by someone who is not a Connection user or by a user who did not log on to
Connection before leaving the message.

Depending on how the system is set up, you may see other types of messages (for example, fax messages)
in your ViewMail for Notes inbox.

To Check a Message

In your ViewMail for Notes inbox, double-click a voice message to open it.

A

Note  You cannot check messages in the Notes Preview pane.

In the open voice message, on the Media Master, select Play (right arrow, second button) to play the
message.

In the message, use the buttons on the message toolbar to manage the message the same way you handle
email messages.

Replying to Voice Messages

Step 1

Do the procedure in this section to reply to a voice message. You can respond to the sender or to all
recipients, and you can add recipients.

A message from “Cisco Unity Connection Messaging System” means that the caller was not a
Connection user or was not logged on when the message was left. You cannot reply to messages from
such callers.

To Reply to a Voice Message

In your ViewMail for Notes inbox, in the open voice message, select Reply, then select Reply, Reply
with History, Reply to All, or Reply to All with History.

OR

From the Actions menu, select Reply, then select Reply with History, Reply to All, or Reply to All
with History.

~

Note  Replying with history is available only in nonsecure messages.
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| Managing Messages with ViewMail for Notes

Step 2
Step 3
Step 4
Step 5

Forwarding Voice Messages I

On the Media Master, select Record (fourth button, circle).
When you finish recording, select Stop (third button, square).
Add text and attachments as applicable.

Select Send.

Forwarding Voice Messages

Step 1

Step 2

Step 3
Step 4
Step 5
Step 6

Do the procedure in this section to forward a voice message as is or to record an introduction that plays
before a forwarded voice message.

To Forward a Voice Message

In your ViewMail for Notes inbox, in the open voice message, select Forward.
OR

From the Actions menu, select Forward.

Enter the names of Connection users or distribution lists, or email addresses.

)

Note  Messages addressed to email addresses are sent as sound (WAV) files attached to email
messages.

On the Media Master, select Record (circle, fourth button) and record an introduction.
When you finish recording, select Stop (square, third button).

Add text and attachments as applicable.

Select Send.

Managing Deleted Messages

Tip

You delete messages from your ViewMail for Notes inbox the same way you delete email messages.

Connection may automatically delete messages once they reach a certain age. Ask your administrator
how long messages are stored before they are permanently deleted for you. This way you can plan to
archive or move important messages ahead of time.

To archive voice messages before deleting them, use the Copy to File option on the Media Master
Options menu (down arrow, first button).
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W Managing Deleted Messages
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Changing Settings for ViewMail for Notes

e Updating the Password in ViewMail for Notes to Match Your Cisco PCA Password, page 27
e Changing Settings for Secure Messaging, and for Phone Recording and Playback, page 28

Updating the Password in ViewMail for Notes to Match Your
Cisco PCA Password

ViewMail for Notes uses your Cisco Unity Connection username and Cisco Personal Communications
Assistant (PCA) password to access your Connection account to retrieve voice messages. You must
update the password in ViewMail for Notes when you change your Cisco PCA password in the
Messaging Assistant web tool. This ensures that ViewMail can continue to access your Connection
account.

If you are having trouble sending or receiving voice messages in ViewMail for Notes, consider the
following tips:

e If Notes prompts you for a password but does not accept it, your Cisco PCA password may have
expired or changed, or it may be locked. Change your Cisco PCA password in the Messaging
Assistant first, then update the password in ViewMail for Notes.

e If youreceive an error when you attempt to play or record messages in ViewMail for Notes by using
the phone, your Cisco PCA password may have expired or changed, or it may be locked. Change
your Cisco PCA password in the Messaging Assistant first, then update it in ViewMail.

e If you receive an error when you attempt to play or record secure messages, your Cisco PCA
password may have expired or changed, or it may be locked. Change your Cisco PCA password in
the Messaging Assistant first, then update it in ViewMail for Notes.

To Update the Password in ViewMail for Notes to Match Your Cisco PCA Password
Step 1 Close your ViewMail for Notes inbox.

Step 2 In Notes, open the Local Names and Address Book.

Step3  From the File menu, select the applicable option, depending on your Notes version:

Notes 8.x Open > Lotus Notes Application
Notes 7.03 and 7.02 Database > Open
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B Changing Settings for Secure Messaging, and for Phone Recording and Playback

Step 4

Step 5
Step 6
Step 7
Step 8
Step 9
Step 10

In the Look In field, leave the applicable value, depending on your Notes version:

Notes 8.x On My Computer
Notes 7.03and 7.02  |Local

In the File Name field, enter names.nsf.

Select the Advanced category, then the Accounts view.

Select your ViewMail for Notes account, then select Edit Account.

In the Password box, enter the new Cisco PCA password that you changed in the Messaging Assistant.
Select Save, then Close.

Open your ViewMail for Notes inbox.

Changing Settings for Secure Messaging, and for Phone
Recording and Playback

Step 1
Step 2
Step 3

The information you enter in the procedure in this section is used by ViewMail for Notes when you want
to record or play messages over the phone, and when you listen to or send secure messages.

As you do the following procedure, if some fields do not already have values entered, you likely will
need to contact your Connection administrator for the required information.

To Change Settings for Secure Messaging, and for Phone Recording and Playback
In your ViewMail for Notes inbox, open a voice message.

On the Media Master, select the down arrow (first button), then select Options.

In the Cisco Unity Connection Server Options dialog, change the applicable settings:

Cisco Unity Connection Enter the IP address or DNS name of the Cisco Unity Connection server.

Server Name . .
Tip Values for the Server Name, Username, Password, and Extension

fields appear automatically if the information was entered during
creation of your ViewMail for Notes account.

User Name Enter your Connection username.

Password Enter your Cisco Personal Communications Assistant (PCA) password.

Remember Password Check the check box for ViewMail for Notes to remember the Cisco PCA
password so that you do not have to re-enter it each time Notes starts.

Proxy Server Address If there is a firewall that blocks HTTPS traffic between user workstations
and the Connection server, enter the IP address of the HTTPS proxy
server.

Proxy Server Port If there is a firewall that blocks HTTPS traffic between user workstations

and the Connection server, enter the server port to use when connecting
to the HTTPS proxy server.
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Changing Settings for Secure Messaging, and for Phone Recording and Playback Il

Validate HTTPS Certificate If your Connection administrator tells you to, check the check box.
Otherwise, leave it unchecked.

Extension Enter your extension.

Step4  Select OK.
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B Changing Settings for Secure Messaging, and for Phone Recording and Playback
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Managing Cisco Unity Connection Voice
Messages in Your Email Application

e About Using Your Email Application to Manage Voice Messages, page 31

¢ Sending Voice Messages from Your Email Application, page 31

e Checking Voice Messages in Your Email Application, page 32

e Deleting Voice Messages in Your Email Application, page 32

e Updating Your Email Application Password to Match Your Cisco PCA Password, page 32

About Using Your Email Application to Manage Voice Messages

With Cisco Unity Connection, you can access voice messages and receipts in your email application.

The location of your voice messages depends on the email application, but typically voice messages are
in a separate folder in your email application. Messages contain a WAV file attachment with the
recording. You play a voice message by opening the attachment.

Depending on how the system is set up, you may see other types of messages (for example, fax messages)
in the folder that contains your voice messages.

Sending Voice Messages from Your Email Application

Note

You cannot record voice messages or replies to voice messages from your email application.

You can reply to voice messages only with text. You can forward voice messages, but if you add an
introduction, the introduction is also only in text.

Depending on how the system is set up, replies or forwarded messages to recipients that are not
Connection users may not be delivered. In that case, you will get a nondelivery receipt (NDR).

When your Cisco Unity Connection mailbox exceeds its size quota, you may not be able to send
messages. (See the “Managing the Size of Your Mailbox” section on page 33.)
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M Checking Voice Messages in Your Email Application

Checking Voice Messages in Your Email Application

Voice messages and receipts typically appear in a separate folder in your email application. Messages

contain a WAV file attachment with the recording. You play a voice message by opening the attachment.

Your email application may notify you of new voice messages in the same way that it notifies you of new
email messages.

The From field of a message will contain either the name of a Connection user or “Unity Connection
Messaging System”—the latter when a message is left by someone who is not a Connection user or by
a user who did not log on before leaving the message. The Subject field displays the phone number of
the caller, if it is available.

Deleting Voice Messages in Your Email Application

You can delete voice messages from your email application, just as you do email messages. Depending
on how the system is set up, you may also be able to retrieve deleted messages in the email application
to listen to them, to restore them to a folder, or to delete them permanently.

For some email applications, you may need to periodically purge your deleted messages folder to
completely delete voice messages. Check with your Connection administrator as to whether this step is
necessary for your email application.

Updating Your Email Application Password to Match Your
Cisco PCA Password

Your email application uses your Connection username and Cisco PCA password to access your
Connection account to retrieve voice messages. You must update the password in your email application
when you change your Cisco PCA password in the Messaging Assistant web tool. This ensures that the
email application can continue to access your Connection account.

If your email application prompts you for a password but does not accept it, your Cisco PCA password
may have expired or changed, or it may be locked. Change your Cisco PCA password in the Messaging
Assistant first, then update it in your email application.

For information on updating the password for your specific email application, contact your Connection
administrator.
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Managing the Size of Your Mailbox

e About Mailbox Size, page 33
e Reasons Your Mailbox May Fill Up Quickly, page 33
e Tips for Managing the Size of Your Mailbox, page 34

About Mailbox Size

A full mailbox can affect the speed at which Cisco Unity Connection processes your messages. When
you log on by phone, Connection notifies you when your mailbox is:

e Almost full.
e Full and you can no longer send new messages.
e Full and you can no longer send or receive new messages.

Your Connection administrator sets the storage limits for your mailbox. Exceeding those limits can
prevent you from sending and receiving messages.

~

Note  System broadcast messages are not included in your total mailbox size.

Reasons Your Mailbox May Fill Up Quickly

If you feel that your Cisco Unity Connection mailbox fills up more quickly than you expect, the reasons
listed below may explain why. (Your Connection administrator specifies the size of your mailbox.)

Message-Retention Policy May Not Be Enforced

Unless your Connection administrator set up the system to enforce a message-retention policy, you are
responsible for managing the size of your mailbox by periodically reviewing your saved messages and
either moving, archiving, or deleting them permanently.

If Connection is set up to enforce a message-retention policy, ask your Connection administrator how
long the system stores your messages before permanently deleting them. You can then plan to archive or
move important messages ahead of time. Connection does not indicate when a message-retention policy
is enforced, nor does it warn you before message are permanently deleted as a result of such a policy.
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| Tips for Managing the Size of Your Mailbox

Deleted Items and Nondelivery Receipts Are Included in Total Mailbox Size

Deleted messages remain in your voice message folder and are included in the total mailbox size until
Connection purges them or until you purge them manually. Ask your administrator how long messages
are stored before they are permanently deleted for you. This way you can plan to archive or move
important messages ahead of time.

In addition, when you receive nondelivery receipts (NDRs) for messages that you send, your mailbox
can quickly increase in size—especially when original messages included large attachments.

Total Message Size Includes Original When Messages Are Forwarded

You may receive messages that have been forwarded many times over, which increases message size.
The original message plus all recorded introductions that were added during forwarding equal the total
message size. As a result, your mailbox can exceed its limit, even though you may have relatively few
messages stored in it.

Total Message Size Includes Attachments

You may receive messages that contain attached files such as spreadsheets, documents, and faxes, or
pictures. The message plus all attached files equal the total message size. As a result, your mailbox can
exceed its limit, even though you may have relatively few messages stored in it.

Tips for Managing the Size of Your Mailbox

The following tips can help you make more room in your mailbox:
e Delete messages.
e Manually purge deleted messages from your voice message folder.

e Move voice messages to a folder on your hard disk before deleting them from your email
application. (This feature is not available on all systems. Ask your Connection administrator
whether it is available to you.)

User Guide for Accessing Cisco Unity Connection Voice Messages in an Email Application (Release 8.x)
‘z - 0L-21247-01



INDEX

in Media Master (ViewMail for Notes) 21
in Media Master (ViewMail for Outlook) 5

checking
A
messages
attachments, effect on mailbox size 34 with ViewMail for Notes 24
automatic voice message playback setting, changing in with ViewMail for Outlook 8

ViewMail for Outlook 12 voice messages in email application 32

Cisco PCA
Cc updating email application password to match 32
updating password
changing in ViewMail for Notes to match 27
automatic voice message playback setting, in in ViewMail for Outlook to match 14

ViewMail for Outlook 12 ] ) ) ] ]
) o . Cisco Unity Connection ViewMail for IBM Lotus Notes.
email application password to match Cisco PCA See ViewMail for Notes
password 32
Cisco Unity Connection ViewMail for Microsoft Outlook.

IMAP account setting, in ViewMail for Outlook 14 See ViewMail for Outlook
password configuring secure messaging settings
in ViewMail for Notes to match Cisco PCA in ViewMail for Notes 28

password 27

in ViewMail for Outlook to match Cisco PCA
password 14

in ViewMail for Outlook 13

playback device D
in Media Master (ViewMail for Notes) 20
in Media Master (ViewMail for Outlook) 4 deleted items, effect on mailbox size 34
preference for saving sent voice messages, in deleted messages, manually purging in ViewMail for
ViewMail for Outlook 12 Outlook 10
recording and playback devices in ViewMail for deleting
Outlook 13 manually purging deleted messages in ViewMail for
recording device Outlook 10
in Media Master (ViewMail for Notes) 20 messages
in Media Master (ViewMail for Outlook) 4 with ViewMail for Notes 25
sound that notifies of new voice messages, in with ViewMail for Outlook 9
ViewMail for Outlook 11 voice messages in email application 32

speaker playback speed for all messages, in Media
Master (ViewMail for Outlook) 5

speaker playback volume for all messages

User Guide for Accessing Cisco Unity Connection Voice Messages in an Email Application (Release 8.x)



W Index

email application
about managing voice messages 31
checking voice messages in 32
deleting voice messages in 32
forwarding voice messages from 31
sending voice messages from 31

updating password to match Cisco PCA password 32

F

forwarded messages, effect on mailbox size 34
forwarding
messages
with ViewMail for Notes 25
with ViewMail for Outlook 9
voice messages from email application 31
full mailbox
notifications of 33

reasons for 33

IMAP account setting, changing in ViewMail for
Outlook 14

K

keyboard shortcuts, Media Master
in ViewMail for Notes 21
in ViewMail for Outlook 6

mailbox
managing size 34
notifications of full 33

reasons for fillingup 33

managing
mailbox size 34
voice messages in email application, about 31
Media Master
in ViewMail for Notes
about 19
changing recording and playback devices 20

changing speaker playback volume for all
messages 21

keyboard shortcuts 21
using sound files in recordings 19
in ViewMail for Outlook
about 3
changing recording and playback devices 4

changing speaker playback speed for all
messages 5

changing speaker playback volume for all
messages 5

keyboard shortcuts 6
using sound files in recordings 4
message retention policy, effect on mailbox size 33
messages
checking
with ViewMail for Notes 24
with ViewMail for Outlook 8
deleting
with ViewMail for Notes 25
with ViewMail for Outlook 9
forwarding
with ViewMail for Notes 25
with ViewMail for Outlook 9
replying to
with ViewMail for Notes 24
with ViewMail for Outlook 8

See also voice messages

nondelivery receipts, effect on mailbox size 34

[l User Guide for Accessing Cisco Unity Connection Voice Messages in an Email Application (Release 8.x)

0L-21247-01



P

passwords, updating

email application to match Cisco PCA 32

in ViewMail for Notes to match Cisco PCA 27

in ViewMail for Outlook to match Cisco PCA 14
playback device, changing

in Media Master (ViewMail for Notes) 20

in Media Master (ViewMail for Outlook) 4

in ViewMail for Outlook 13

receipts, checking in email application 32
recording device, changing
in Media Master (ViewMail for Notes) 20
in Media Master (ViewMail for Outlook) 4
in ViewMail for Outlook 13
recordings, using sound files
in ViewMail for Notes 19
in ViewMail for Outlook 4
replying to messages
with ViewMail for Notes 24
with ViewMail for Outlook 8

S

secure messaging settings, configuring
in ViewMail for Notes 28
in ViewMail for Outlook 13
sending voice messages
from email application 31
with ViewMail for Notes 23
with ViewMail for Outlook 7

sent voice messages, changing preference for saving in
ViewMail for Outlook 12

shortcuts, keyboard for Media Master
in ViewMail for Notes 21
in ViewMail for Outlook 6

Index W

sound files, using in recordings
in ViewMail for Notes 19
in ViewMail for Outlook 4

sound that notifies of new voice messages, changing in
ViewMail for Outlook 11

speed, changing speaker playback for all messages, in
Media Master (ViewMail for Outlook) 5

T

tips for managing mailbox size 34

U

Unity Connection Messaging System, voice messages from
in ViewMail for Notes 24
in ViewMail for Outlook 8

updating

email application password to match Cisco PCA
password 32

password

in ViewMail for Notes to match Cisco PCA
password 27

in ViewMail for Outlook to match Cisco PCA
password 14

\'"/

ViewMail for Notes
checking messages 24
configuring secure messaging settings 28
forwarding messages 25
Help, accessing 17
managing deleted messages 25
replying to messages 24
sending voice messages 23

updating password in to match Cisco PCA
password 27

ViewMail for Outlook

about 1

User Guide for Accessing Cisco Unity Connection Voice Messages in an Email Application (Release 8.x)



Index

changing automatic voice message playback
setting 12

changing preference for saving sent voice
messages 12

changing recording and playback devices 13

changing sound that notifies of new voice
messages 11

changing your IMAP account setting 14
checking messages 8

configuring secure messaging settings 13
forwarding messages 9

Help, accessing 1

managing deleted messages 9

manually purging deleted messages 10
replying to messages 8

sending voice messages 7

updating password in to match Cisco PCA
password 14

voice messages

volume, changing speaker playback for all messages

[l User Guide for Accessing Cisco Unity Connection Voice Messages in an Email Application (Release 8.x)

about managing in email application 31
checking in email application 32
deleting in email application 32
forwarding from email application 31
from Unity Connection Messaging System

in ViewMail for Notes 24

in ViewMail for Outlook 8
See also messages
sending

from email application 31

with ViewMail for Notes 23

with ViewMail for Outlook 7

in Media Master (ViewMail for Notes) 21
in Media Master (ViewMail for Outlook) 5

0L-21247-01



	User Guide for Accessing Cisco Unity Connection Voice Messages in an Email Application
	Contents
	About ViewMail for Outlook (Version 8.0 Only)
	Working with the Media Master in ViewMail for Outlook (Version 8.0 Only)
	About the Media Master (Version 8.0 Only)
	Using Sound Files in Your Recordings (Version 8.0 Only)
	Changing Recording and Playback Devices with the Media Master (Version 8.0 Only)
	Changing Message Playback Volume When Computer Speakers Are Your Playback Device (Version 8.0 Only)
	Changing Message Playback Speed When Computer Speakers Are Your Playback Device (Version 8.0 Only)
	Media Master Keyboard Shortcuts (Version 8.0 Only)

	Managing Messages with ViewMail for Outlook (Version 8.0 Only)
	Sending Voice Messages (Version 8.0 Only)
	Checking Messages (Version 8.0 Only)
	Replying to Messages (Version 8.0 Only)
	Forwarding Voice Messages (Version 8.0 Only)
	Managing Deleted Messages (Version 8.0 Only)

	Changing Settings for ViewMail for Outlook (Version 8.0 Only)
	Changing the Sound That Notifies You of New Voice Messages (Version 8.0 Only)
	Changing the Automatic Voice Message Playback Setting (Version 8.0 Only)
	Changing Your Preference for Saving Sent Voice Messages (Version 8.0 Only)
	Changing Recording and Playback Devices (Version 8.0 Only)
	Configuring Your Secure Messaging Settings (Version 8.0 Only)
	Changing Your IMAP Account Setting (Version 8.0 Only)
	Updating the Password in ViewMail for Outlook to Match Your Cisco PCA Password (Version 8.0 Only)

	About ViewMail for Notes
	Working with the Media Master in ViewMail for Notes
	About the Media Master
	Using Sound Files in Your Recordings
	Changing Recording and Playback Devices with the Media Master
	Changing Message Playback Volume When Computer Speakers Are Your Playback Device
	Media Master Keyboard Shortcuts

	Managing Messages with ViewMail for Notes
	Sending Voice Messages
	Checking Messages
	Replying to Voice Messages
	Forwarding Voice Messages
	Managing Deleted Messages

	Changing Settings for ViewMail for Notes
	Updating the Password in ViewMail for Notes to Match Your Cisco PCA Password
	Changing Settings for Secure Messaging, and for Phone Recording and Playback

	Managing Cisco Unity Connection Voice Messages in Your Email Application
	About Using Your Email Application to Manage Voice Messages
	Sending Voice Messages from Your Email Application
	Checking Voice Messages in Your Email Application
	Deleting Voice Messages in Your Email Application
	Updating Your Email Application Password to Match Your Cisco PCA Password

	Managing the Size of Your Mailbox
	About Mailbox Size
	Reasons Your Mailbox May Fill Up Quickly
	Message-Retention Policy May Not Be Enforced
	Deleted Items and Nondelivery Receipts Are Included in Total Mailbox Size
	Total Message Size Includes Original When Messages Are Forwarded
	Total Message Size Includes Attachments

	Tips for Managing the Size of Your Mailbox

	Index

